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Configuration and Installation
This section provides instructions for configuring and installing Interaction Concentrator, the
Interaction Database (IDB), DB Server, and a Database Access Point (DAP).

Important
DB Server and the DAP are Framework components required to use IDB.

Deployment Order

Recommended Deployment Order

Before you deploy Interaction Concentrator, review Planning Your Deployment, and ensure that you
have accounted for all prerequisites for the installation.

Then deploy Interaction Concentrator in the following order:

[+] 1. Host configuration objects
Use Configuration Manager to configure a Host configuration object for the computers on which the
DB Server and Interaction Concentrator (ICON) server applications will reside.

For information about Genesys configuration objects, see the Framework Configuration Manager Help.

[+] 2. Telephony objects
Use Configuration Manager to make any modifications to the telephony objects on which ICON will
report, including the Switch object for the PBX and any DN (Directory Number) objects that are
configured for this Switch object.

For configuration settings that are specific to ICON,see the sections on Switch Configuration Options
and DN Configuration Options.

[+] 3. DB Server
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Tip
If you decide to use a DB Server that serves another application for Interaction
Concentrator storage purposes, you can skip this step.

To configure and install a DB Server that will handle ICON requests for IDB data storage, use standard
deployment instructions from the Framework Deployment Guide. (See also the DB Server tab for the
major steps in the procedure.)

For performance reasons, Genesys recommends that you set up the DB Server on the same host as
the RDBMS server. In an environment with multiple IDB instances at separate sites, deploy one DB
Server per IDB. In an environment with multiple IDB instances at the same site, deploying one DB
Server for all IDB instances is sufficient.

[+] 4. Interaction Concentrator
Configure and install Interaction Concentrator.

In an environment with multiple ICON instances, repeat the configuration and installation steps for
each ICON instance, making the necessary adjustments when you configure ICON connections and
configuration options.

[+] 5. Interaction Database
Install a database for ICON data on one of the supported RDBMSs and initialize IDB. In an
environment with multiple IDB instances, repeat the steps to create IDB for each IDB instance.

[+] 6. Database Access Point

1. Configure a DAP Application object that specifies IDB connection parameters.
2. In an environment with multiple ICON instances, each of which stores data to its own IDB instance,

repeat the steps to create a separate DAP for each IDB instance. If you decide to write different types of
data from a single ICON instance to different databases, also configure a separate DAP for each
database.

3. Ensure that the role settings that you specify for the DAP are consistent with the role settings specified
for the ICON instance that it serves.

DB Server
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Deploying DB Server

After you configure Host objects for Interaction Concentrator components, deploy as many instances
of DB Server as you need using the following procedure:

1. Import the application template for DB Server.
2. Configure an Application object for DB Server.
3. Install DB Server on its host.
4. Set up any environment variables that are specific to your RDBMS type.

For detailed instructions, see the Framework DB Server User’s Guide.

ICON

Deploying ICON

This section explains how to deploy as many instances of Interaction Concentrator as you need on
either a UNIX or a Windows operating system.

Important
Interaction Concentrator supports silent installation on Windows platforms. Also
known as a silent setup, it enables you to install Interaction Concentrator without
having to monitor the setup or provide input via dialog boxes. For instructions, see
"Appendix E: Silent Setup" in the Framework 8.1 Deployment Guide.

Environment Assumptions
The instructions in this section assume that you are creating new Application objects under the
Environment folder in Configuration Manager, in either a single-tenant or multi-tenant configuration
environment. To create Application objects under a particular Tenant folder in a multi-tenant
configuration environment, replace the word Environment with the name of your Tenant folder in the
configuration instructions.

[+] 1. Import the Application Template
Before you can configure an Application object for Interaction Concentrator, you must import its
application template. The application template provides a majority of the configuration options, as
well as the default values for them. You can use this Application Template to create as many
Application objects of the same type as you need.

1. Open the Configuration Manager main window.
2. Select the Environment > Application Templates folder.
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3. From the File menu, select Import Application Template.
4. In the Look In box, click the down arrow.
5. Locate the Interaction Concentrator 8.1 product CD, and open the TEMPLATES folder.
6. Select the template file for Interaction Concentrator; it is called Interaction_Concentrator_81x.apd.
7. Click Open to open the Properties dialog box for the template.
8. Make any changes that you require.
9. Click OK to save the template and close the Properties dialog box.

The next step is to configure an Interaction Concentrator Application object.

[+] 2. Create an ICON Application Object
After you import the application template, you can create and configure an Application object for your
Interaction Concentrator by using Configuration Manager.

1. Open the Configuration Manager main window.
2. Select the Environment > Applications folder.
3. From the File menu, select New > Application.
4. From the available application templates in the Browse dialog box, select the template that you

imported for Interaction Concentrator.
5. On each of the Application tabs, enter the settings appropriate for your environment.

[+] 3. Configure the General tab
In the Properties dialog box, click the General tab, and then enter a name for this application.

Tip
The application template provides information about the application type and version.
Interaction Concentrator uses the Call Concentrator application type for its Application
object in the Configuration Layer.

[+] 4. Configure the Server Info tab
Click the Server Info tab, and then specify the following properties:

• Host—Enter the name or IP address of the computer on which you want to install and/or run this server.
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Important
In IPv6 deployments, you cannot set the IP address of the host—only IPv4 addresses
can be set for the host. Therefore, enter the name of the host instead.

• Communication Port—Enter a numeric value for a port that is not used by another application. Valid
values are in the range of 1–65,535. ICON uses this value as the default listening port for the web
interface connection.

[+] 5. Configure the Start Info tab

Tip
The properties you define here are updated automatically during the installation
procedure.

Click the Start Info tab, and then specify the following properties:

• Working Directory—Enter the full path to the directory from which the application starts.
• Command Line—Enter the command line that is used to start the application.
• Command Line Arguments—Enter any additional command-line parameters that are used to start the

application. For information about command-line parameters, see "Command-Line Parameters" on the
Starting and Stopping page.

[+] 6. Configure the Options tab
Click the Options tab, and then specify or change the values of the configuration options, as suitable
for your deployment.

• For information about specific configuration requirements to enable ICON to capture and store various
types of data (such as voice, multimedia, Outbound, and so on), see Special Configuration
Requirements.

• For information about the entire set of ICON configuration options, see Configuration Options.

Role Option

• If you have already deployed another ICON instance that writes to the same IDB, make sure that only
one of the ICON applications is configured to store configuration data and the history of configuration
changes. For all other instances, deactivate the configuration data storage by configuring one of the
following values for the role option in the callconcentrator section:
• Explicitly specify one or more values other than cfg.
• Exclude the cfg value by using the tilde symbol (~) (that is, set the role option to ~cfg).

Configuration and Installation

Interaction Concentrator Deployment Guide 6



• For more information about the role option, see the role configuration option description on the
Configuration Options page. For more information about role assignments and restrictions for the cfg
role, see "Recommended Role Assignments" on the ICON Roles page.

Log Options

• Configure both ICON-specific log options and common log options in the log-related configuration
sections. For option descriptions, see the log options section on the Configuration Options page and the
Framework Configuration Options Reference Manual.
• If the Interaction Concentrator working directory differs from the directory to which the application is

installed, configure an option named messagefile in the log section. As the value of this option,
specify the full path to the application-specific log messages file (icon.lms). Otherwise, ICON will
be unable to generate its specific log events.

HTTP Listener

• Configure an HTTP listener by creating a listeners section and specifying the appropriate option. For
option descriptions, see the listeners section on the Configuration Options page.

[+] 7. Configure the Tenants tab

Tip
The Tenants tab is displayed only in a multi-tenant environment.

• Click the Tenants tab, and then click Add to add all tenants that this ICON application will serve.

It is important to add all tenants from whose resources (switches, DNs, agents, and, if applicable,
Outbound Contact objects) ICON will collect data.

• If this ICON instance is required to monitor the objects that are configured under the Environment
folder, assign the Environment tenant among the other tenants.

[+] 8. Configure the Connections tab
>
Click the Connections tab, and then add the following connections: {{NoteFormat|For any
connections between the ICON instance and its data sources, you can configure the connection to
use Advanced Disconnect Detection Protocol (ADDP). To enable ADDP for a connection, specify addp
as the Connection Protocol when you configure the connection between the Applications, and set the
values for the Local Timeout, Remote Timeout, and Trace Mode properties. For more information, see
the Framework Deployment Guide.

• If this ICON instance is configured to process CTI-related data, add a connection to T-Server. Note the
following special requirements:
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• If you have a simple multi-site topology that includes one ICON instance and multiple T-Servers, add
a connection to each T-Server. Each T-Server Application object must have a Switch object assigned
to it.

• In a deployment with Network T-Server, add a connection to the Network T-Server. The Network T-
Server Application object must have a network Switch object assigned to it.

• In a deployment in which the Network T-Servers function in load-balancing mode, add a connection
to each Network T-Server. For more information, see "Multiple Network T-Servers per Switch (Load-
Balancing Configuration)" on the Supported Deployment Scenarios page.

Important
Starting in release 8.1.4, if host or port information changes for any T-Server listed on
the Connections tab, Interaction Concentrator dynamically reconnects using the new
connection parameters. While ICON disconnects from the prior host/port and connects
to the new one, there might be a brief gap in data received from the T-Server.
In releases 8.1.0 and 8.1.1, you must restart ICON for updates to listed T-Servers to
take effect.

• If this ICON instance is configured to process multimedia interactions reported by Interaction Server,
add a connection to Interaction Server. The Interaction Server must be of type T-Server (for details on
configuring Interaction Server correctly, see the information about ICON connections in the section,
"Storing Multimedia Data" on the Special Configuration Requirements page.

Important
If you are installing ICON in a deployment that will use Genesys Info Mart to report on
both voice and multimedia interactions, you must create separate ICON instances and
separate IDBs for the voice and multimedia data.

• If this ICON instance is configured to process outbound data in an environment with Genesys Outbound
Contact, add a connection to one or more OCS applications.

• Add a connection to the Configuration Server application (named confserv). You can enable ADDP for
connections to Configuration Server in the same way as for other connections.
• Genesys recommends that, at a minimum, you add a connection to Configuration Server in the ICON

instance that is configured to process configuration data (cfg role). However, to minimize the
number of unidentified call segments that might occur as a result of missing configuration data,
Genesys recommends that you configure an ADDP connection to Configuration Server in each ICON
Application in your deployment, regardless of the role of the ICON Application.

• If you installed the Management Layer, add a connection to Message Server, in order to provide alarm
signaling and centralized logging capabilities. You can add a connection to Message Server for all or a
set of Application objects after you configure them. To launch a wizard that configures connections for
multiple Application objects, select two or more Application objects, right-click, and then select Manage
Connections from the shortcut menu. For more information, see the Framework Configuration Manager
Help.

• After you configure one or more DAP Application objects (see the DAP tab on the Configuration and
Installation page), add to the ICON Connections tab any DAP Application objects through which this
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ICON instance will access IDBs.
• In high availability (HA) environments using primary and backup pairs of servers, the servers listed on

the Connections tab are handled as primary. To specify the backup servers for any primary servers,
open the Application object for the primary server and add the backup server on the primary server’s
Server Info tab. Click OK to save your changes, then close the Properties dialog box.

IDB

Creating IDB

You can use any of the supported RDBMSs to host your IDB. Ask your Database Administrator to
create a new database for each IDB instance that you intend to deploy for ICON data storage. Then,
initialize each IDB instance, using the instructions in this section. {{NoteFormat|The user account
that is created for IDB must have permissions to create database objects such as tables, stored
procedures, and sequences.

The IDB initialization scripts create default (empty) custom dispatchers without first dropping any
existing stored procedures named gudCustDISP1 and gudCustDISP2. This is to decrease the risk of
overwriting customer-created stored procedures. However, if the gudCustDISP1 and gudCustDISP2
custom dispatcher stored procedures already exist in IDB, the CoreSchema_<db_type>.sql script
returns an error, which is safe to ignore.

Genesys provides the SampleProc_<db_type>.sql script to help you understand how you can modify
the stored procedures for customized attached data processing. Do not execute the sample script
during installation. For more information about configuring your ICON application to support
customized attached data processing, see the Attached Data tab on the Special Configuration
Requirements page. For an example of a script to create a custom dispatcher stored procedure and
custom storage table, see Sample Script for Custom Attached Data.

[+] Initialization Scripts
After you install the ICON application, the scripts subfolder in the directory to which you installed
ICON contains a set of initialization, migration, and sample scripts for each RDBMS type. See
Initialization Scripts on the IDB tab of Configuration and Installation for a list of these scripts and the
purpose of each. In the script names, <db_type> is a placeholder for the specific RDBMS type (db2,
mssql, postgre, or ora [for Oracle]).

Warning
If you are migrating from an existing IDB, do not simply apply all the scripts listed
under Initialization Scripts on the IDB tab of Configuration and Installation. To avoid
damaging or erasing existing data, follow the migration procedures that are described
in the Interaction Concentrator chapters in the Genesys Migration Guide and in the
Interaction Concentrator 8.1 Deployment Procedure.
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If you are running Genesys Info Mart 8.1.1 or 8.1.0, see Scripts Required for Environments Running Genesys
Info Mart 8.1.1 or 8.1.0 below.

Table of Initialization Scripts
Script Name Description

CoreSchema_<db_type>.sql (For initial installation only) Creates the core IDB
tables and indexes.

Upgrade_<target_database_version>_<db_type>.sql

(For migration only) Upgrades the IDB schema.
The scripts you must execute depend on the releases from
which and to which you are upgrading. For more information,
see the instructions in the Interaction Concentrator chapters in
the Genesys Migration Guide or the Interaction Concentrator 8.1
Deployment Procedure.

CoreProcedures_<db_type>.sql
Creates the database schema–specific set of stored
procedures that implement core ICON functionality,
including the merge procedures and the separate
procedures to purge different types of data.

Purge2_<db_type>.sql
Creates the gsysPurge80 or gsysPurge81 stored
procedure.The version created corresponds to the
release of Interaction Concentrator you are
installing.

Wrapper_for_<schema version>_<db_type>.sql
Links generically named merge and purge
procedures to the equivalent, schema-specific
stored procedures in the new set.

drop_<schema version>_<db_type>.sql
(Optional, for migration only) Removes the set of
stored procedures for the specified Interaction
Concentrator schema version.

SampleProc_<db_type>.sql
Serves as a sample script, illustrating how to create
a custom attached data storage table and modify
the custom dispatcher stored procedures.

CoreSchemaPart_ora.sql
(Optional, for Oracle RDBMSs only) Creates tables,
sequences, and indexes for use in a partitioned
schema.

PurgePart_ora.sql
(Optional, for Oracle RDBMSs only) Creates the
stored procedure required to purge a partitioned
Oracle IDB.

Scripts Required for Environments Running Genesys Info Mart 8.1.1 or 8.1.0
For environments that include Genesys Info Mart 8.1.1 or an earlier 8.1.x release, run the appropriate
script as described in this section every time you migrate to a new release of Interaction
Concentrator. (Starting with release 8.1.4, Genesys Info Mart automatically runs the scripts when
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required.)

Tip
For the location of the scripts and detailed instructions, see the Genesys Info Mart 8.1
Deployment Procedure or the Genesys Info Mart 8.1 Deployment Guide.

• For a Voice details IDB, use update_idb_for_gim.sql.
• For a Multimedia details IDB, use update_idb_for_gim_mm.sql.
• For a Configuration details or an Outbound Contact details IDB, use either update_idb_for_gim.sql or

update_idb_for_gim_mm.sql.

[+] Initializing IDB
For a first-time initialization of IDB, follow the RDBMS-specific instructions in the following procedures:

Initializing IDB on DB2

To initialize IDB by running the initialization scripts provided for a DB2 database:

1. Go to the directory into which you installed ICON.
2. Go to the scripts\db2 subdirectory.
3. Execute the following scripts in the order shown:

1. CoreSchema_db2.sql

2. CoreProcedures_db2.sql

3. Purge2_db2.sql—This script is optional. Execute this script if you want to use the gsysPurge80/
gsysPurge81 stored procedure in your deployment.

4. Wrapper_for_<schema version>_db2.sql—Execute this script if your deployment will use the
gsysIRMerge or gsysIRMerge2 merge procedure, or if your deployment will use the gsysPurgeIR,
gsysPurgeUDH, gsysPurgeLS, or gsysPurgeOS purge procedures.

4. To execute the scripts:
• Insert the following command line at the beginning of each script, providing appropriate values for

the placeholders:

db2 connect to <dbname> user <user> using <password>

• Use the following command line to load each initialization script:

db2 -w -td@ -f<script_name>
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Initializing IDB on Microsoft SQL

To initialize IDB by running the initialization scripts provided for a Microsoft SQL database:

1. Go to the directory into which you installed ICON.
2. Go to the scripts\mssql subdirectory.
3. Execute the following scripts in the order shown:

1. CoreSchema_mssql.sql

2. CoreProcedures_mssql.sql

3. Purge2_mssql.sql—This script is optional. Execute this script if you want to use the gsysPurge80/
gsysPurge81 stored procedure in your deployment.

4. Wrapper_for_<schema version>_mssql.sql—Execute this script if your deployment will use the
gsysIRMerge or gsysIRMerge2 merge procedure, or if your deployment will use the gsysPurgeIR,
gsysPurgeUDH, gsysPurgeLS, or gsysPurgeOS purge procedures.

4. To execute the scripts, use the following command line to load each initialization script, providing
appropriate values for the placeholders:

sqlcmd -S <dbms_server> -d <dbname> -U <user> -P <password> -i <script_name>

where sqlcmd is isql.exe or osql.exe

Initializing IDB on Oracle

To initialize IDB by running the initialization scripts provided for an Oracle database:

1. Go to the directory into which you installed ICON.
2. Go to the scripts\oracle subdirectory.
3. Execute the following scripts in the order shown, unless you are creating a partitioned Oracle database,

in which case use the list of scripts that follows the standard set.
• To execute the scripts, log in to the sqlplus command processor, and type the following at the

command prompt:

@ <script_name>

• For a standard Oracle IDB, run the following scripts:

1. CoreSchema_ora.sql

2. CoreProcedures_ora.sql

3. Purge2_ora.sql—This script is optional. Execute this script if you want to use the gsysPurge80/
gsysPurge81 stored procedure in your deployment.

4. Wrapper_for_<schema version>_ora.sql—Execute this script if your deployment will use the
gsysIRMerge or gsysIRMerge2 merge procedure, or if your deployment will use the gsysPurgeIR,
gsysPurgeUDH, gsysPurgeLS, or gsysPurgeOS purge procedures.

• If you are using partitioning on Oracle, run the following scripts instead:
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1. CoreSchemaPart_ora.sql (instead of CoreSchema_ora.sql)
2. CoreProcedures_ora.sql

3. PurgePart_ora.sql (instead of Purge2_ora.sql).Execute this script if you want to purge a
partitioned IDB by truncating partitions. This purge method can speed up the purge process in large
deployments.

• For detailed information on partitioning, a list of the tables that can be partitioned, and how purging
works in a partitioned IDB, see "Purging by Truncating Partitions" section in the "Using Special Stored
Procedures" of the Interaction Concentrator 8.1 User’s Guide.

• For instructions on starting to use a partitioned IDB, see the Interaction Concentrator section of the
Genesys Migration Guide.

Initializing IDB on PostgreSQL

To initialize IDB by running the initialization scripts provided for a PostgreSQL database:

1. Go to the directory into which you installed ICON.
2. Go to the scripts\postgre subdirectory.
3. Execute the following scripts in the order shown:

1. CoreSchema_postgre.sql

2. CoreProcedures_postgre.sql

3. Purge2_postgre.sql—This script is optional. Execute this script if you want to use the gsysPurge81
stored procedure in your deployment.

4. Wrapper_for_<schema version>_postgre.sql—Execute this script if your deployment will use the
gsysPurgeIR, gsysPurgeUDH, gsysPurgeLS, or gsysPurgeOS purge procedures.

4. To execute the scripts, use the following command line to load each initialization script, providing
appropriate values for the placeholders:

psql -h <dbms_server> -U <user> --dbname=<dbname> --file=<script_name>

Important
PostgreSQL is supported for use with Genesys Info Mart 8.x, which does not use the
Interaction Concentrator merge stored procedures.

DAP
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Configuring a DAP

If you are unsure how to use Configuration Manager to create a new DAP Application object, refer to
one of the following sources:

• Appendix A, “Standard Configuration Procedure” of the Framework Deployment Guide
• Framework DB Server User’s Guide

In addition to the standard configuration steps, complete the following procedure:

1. On the General tab, when you specify the application name, keep in mind that the DAP can have the
same name as the database itself. However, if you are using multiple access points to the same
database, make their names unique.

2. On the General tab, click Browse to locate the DB Server through which this database is to be
accessed. This must be the DB Server that is either deployed or reused for ICON purposes (see the DB
Server tab on the Configuration and Installation page).

3. Do not select the JDBC Connection check box, because it does not apply to database connections
through DB Server.

4. On the DB Info tab, specify the properties as follows:
• DBMS Name—The name or alias that identifies the RDBMS that handles IDB. The value of this option

is communicated to DB Server so that it connects to the correct RDBMS:
• For Oracle, set the value to the name of the Listener service (also known as a database alias).
• For Microsoft SQL, set the value to the name of the SQL server (usually the same as the host

name of the computer on which Microsoft SQL runs).
• For PostgreSQL, set this value to the SQL server name (usually the same as the host name of the

computer where PostgreSQL runs), as configured in the DB Server Application.
• For DB2, set the value to the name or alias name of the database, as specified in the db2 client

configuration.

• DBMS Type—The type of RDBMS that handles IDB. You must set a value for this property.
• Database Name—The name of the IDB instance to be accessed, as it is specified in the RDBMS that

handles this database. You must set a value for this property, unless you specify oracle or db2 for
DBMS Type. For Microsoft SQL and PostgreSQL, the value is the name of the database to which the
client will connect.

• User Name—The user name for accessing IDB, as established in the SQL server. You must set a
value for this property.

• Password—The password for accessing IDB, as established in the SQL server.
• Re-enter Password—Confirmation for the value that you entered for Password.
• Case Conversion—The case conversion method for key names of key-value lists that come from DB

Server. This value specifies whether, and how, a client application converts the field names of a
database table when it receives data from DB Server. This parameter does not affect the values of
key-value lists that come from DB Server—the actual data is presented exactly as it appears in the
database tables.
• upper—Field names are converted into uppercase.
• lower—Field names are converted into lowercase.
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• any—Field names are not converted. Use the default value (any), unless Genesys Customer Care
directs you to do otherwise.

5. When configuring a DAP Application object for IDB, do not configure any properties on the JDBC Info tab.
6. If you intend to use multiple database access points to write different types of ICON data to different

databases, specify which type(s) of data this particular database access point must handle. To do
so,perform the following steps:
1. On the Options tab, create a section named callconcentrator.
2. Within the callconcentrator section, create a configuration option named role.
3. Set the option value to indicate the types of data that will be stored through this DAP. For more

information, see description of the role option under ICON Role in the callconcentrator section of
the Configuration Options page. The role option values must be lower-case (for example, cfg).
ICON interprets role option values in uppercase (CFG) or mixed case (Cfg) as invalid and defaults to
the all role.
• For optimal performance, Genesys recommends the following sets of values for a given database

access point:
• gcc,gud,gls

• cfg

• gos

7. After you configure a DAP Application object, add it to the Connections tab of the ICON application that
will use this DAP as an interface to IDB.
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